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 Paper-based colorimetric sensors have been widely applied as cost-effective 
tools for on-site pesticide detection. The availability of inexpensive imaging 
technologies, such as smartphones, has enhanced the efficiency of detection 
methodologies. This work describes the development of an image analysis-
assisted paper-based colorimetric aptasensor for malathion (MLT) detection. 
The sensing paper was fabricated by immobilizing a mixture of citrate-capped 
gold nanoparticles (cit-AuNPs) and thiolated DNA aptamer (Apt) onto 
Whatman filter paper. After a 3-minute reaction, the paper exhibited a visible 
color change in the presence of MLT due to cit-AuNP aggregation. Smartphone 
images of the sensing paper, captured before and after MLT addition, were 
processed using ImageJ software to obtain red, green, and blue (RGB) values, 
with the response expressed as ΔRGB. The aptasensor achieved a limit of 
detection (LOD) of 0.67 μM with a linear range of 100–1,000 μM. This paper-
based colorimetric aptasensor provides a simple and rapid method for on-site 
MLT detection. 
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Introduction  

Global farming practices largely depend on 

pesticides to protect crops from pests, diseases, 

and weeds, which can otherwise lead to a 

significant loss in yield and quality [1]. Based on 

FOA [2], the global use of pesticides in 2020 has 

been increased, amounting 2.7 million tonnes 

(Mt) of active ingredients with Asia was recorded 

as the most land at a high risk of pesticide 

pollution (1.9 million square miles) [1]. Pesticide 

pollution may occur through various pathways 

including runoff and leaching by rainfall, or spray 

drift during application which carried by wind, 

affecting non-target plants or ecosystem [3]. 

Among various classes of pesticides, 

organophosphates (OPs) are widely used not only 

for pest control, but also as chemical warfare 

agents, raising concerns about their impact on 

human health and the environment [4]. Due to 

their high toxicity and potential for exposure, OPs 

pose significant health risks to humans, 

particularly through the inhibition of 

acetylcholinesterase, which can lead to severe 

neurological and respiratory symptoms if not 

treated promptly [5,6]. This risk is further 

exacerbated by OPs contamination in food and 

water sources, underscoring the need for efficient 

detection methods to ensure food safety and 

environmental protection [7]. 

Emerging evidence suggests that 

organophosphate metabolites and degradation 

products, which may be more toxic than the 

parent compounds, can persist in the 

environment for extended periods, posing risks to 

non-target organisms, soil health, and water 

quality through runoff and leaching into aquatic 

ecosystems [8,9]. Despite regulatory efforts to 

mitigate pesticide risks, the improper use and 

overreliance on OPs in agriculture continue to 

raise concerns regarding human health, 

environmental sustainability, and the 

development of pesticide resistance in target 

pests [10]. As mentioned by Mostafalou & 

Abdollahi [11], OPs have been associated with 

wide range of adverse health effects on humans, 

including acute toxicity, neurotoxicity, 

developmental disorders, and increased risk of 

certain cancers. Therefore, accurate and efficient 

detection methods are essential to ensure food 

safety and environmental protection. 

Conventional detection methods for OPs typically 

involve complex instrumentation (e.g., high 

performance liquid chromatography (HPLC), gas 

chromatography (GC), enzyme linked 

immunosorbent assay (ELISA)), complicated 

procedures, and skilled personnel that making 

them impractical for on-site and rapid screening 

applications [12,13]. Hence, there is a demand for 

the development of simple, cost-effective, and 

rapid detection techniques that can be deployed 

in resource-limited settings [14]. In contrast, 

colorimetric analysis, particularly when 

employed in paper-based sensors, offers a simple, 

rapid, and cost-effective alternative for pesticide 

detection [15]. 

Colorimetric sensors utilize specific chemical 

reactions between analytes and color-changing 

reagents, producing visible color changes that can 

be easily observed with the naked eye or 

quantified using portable devices [16]. Compared 

to the conventional methods, colorimetric 

analysis eliminates the need for sophisticated 

equipment and extensive sample preparation, 

making it suitable for on-site and field 

applications [17]. Additionally, colorimetric 

sensors can be designed for multiplex detection of 

multiple analytes simultaneously, further 

enhancing their utility for screening purposes 

[18]. Despite their simplicity, colorimetric sensors 

demonstrate competitive sensitivity and 

selectivity, offering a promising approach for 

rapid and accessible detection of pesticide 

contamination in various matrices [19]. 

Paper-based analytical devices (PADs) have 

been increasingly employed for environmental 

monitoring, including the detection of pesticide 

residues in water sources, soil, and air, 
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highlighting their versatility and relevance in 

addressing environmental challenges [20]. In 

recent years, PADs have gained significant 

attention as promising platforms for pesticide 

detection due to their simplicity, portability, low 

cost, and ease of fabrication [21,22]. Recent 

studies have shown significant advancements of 

PADs, particularly in terms of sensitivity, 

selectivity, and fabrication techniques [23]. 

Incorporating nanomaterials such as gold 

nanoparticles (AuNPs) and carbon nanotubes into 

PADs has been shown to enhance their detection 

capabilities for various analytes, including 

pesticides [24]. Coupled with colorimetric 

detection strategies, these sensors offer a 

convenient means for visualizing analyte 

concentrations without the need for specialized 

equipment, as they provide a visible and easily 

interpretable response [25,26]. 

Detecting pesticides in water using smartphone 

platforms offers a promising avenue for rapid and 

accessible environmental monitoring [27]. 

Leveraging the computational capabilities and 

connectivity of smartphones, innovative 

aptasensor technologies can be integrated to 

enable real-time detection and analysis of 

pesticide residues in water samples [28]. 

Recently, the integration of smartphones in 

detecting pesticides residues in environmental 

samples has earned significant research attention 

[29–31]. By coupling paper-based colorimetric 

aptasensor or other portable detection platforms 

with smartphone applications, users can easily 

capture images of the colorimetric response and 

receive instant feedback on pesticide 

concentrations [32]. According to Ateia et al. [33], 

this approach not only enhances the efficiency 

and convenience of pesticide monitoring, but also 

empowers communities, researchers, and 

regulatory agencies to monitor water quality 

more effectively and respond promptly to 

potential contamination events. Furthermore, the 

widespread availability of smartphones ensures 

that this technology can be deployed across 

diverse geographical locations, facilitating 

comprehensive monitoring efforts and 

contributing to the protection of water resources 

and public health. In this study, paper-based 

colorimetric aptasensor for rapid detection of 

MLT was developed. A commercial laboratory 

filter paper (Whatman filter paper Grade 1) was 

modified with deposition of cit-AuNPs and Apt. 

The colour of the modified filter papers before and 

after detection with MLT were captured in an 

image capturing box using a smartphone at a fixed 

distance between the modified filter paper and 

the smartphone. The image capturing box was 

designed using three-dimensional (3D) printer to 

enable fast prototyping. The captured images 

were easily interpreted using ImageJ. By 

combining the simplicity and portability of paper-

based aptasensors with the smartphones, this 

study aimed to develop a robust sensing platform 

capable of detecting MLT at micromolar (100-

1000 µM) levels, thereby enabling timely 

intervention and mitigation of pesticide 

contamination in food and water resources. 

Experimental  

Materials and reagents 

The chemicals used in this study are gold (III) 

chloride trihydrate (HAuCl4·3H2O), MLT 

(C10H9O6PS2) and acetonitrile (CH3CN), which 

were purchased from Sigma-Aldrich (USA), 

whereas trisodium citrate dihydrate 

(C6H5Na3O7·2H2O) was obtained from Merck 

(German). The Whatman® qualitative filter paper 

(Grade 1) with thickness of 180 µm and diameter 

of 90 mm was obtained from Cytiva 

(Marlborough, USA). The IDTE solution and thiol-

modified DNA aptamer (Apt) used in this study 

was provided by integrated DNA Technologies 

(Singapore) with a sequence of 5’ -ThioMC6D-ATC 

CGT CAC ACC TGC TCT TAT ACA CAA TTG TTT 

TTC TCT TAA CTT CTT GAC TGC TGG TGT TGG 

CTC CCG TAT-3’. The sequence of the thiolated 
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DNA aptamer was prepared according to Abnous 

et al. [34]. 

Synthesis of citrate capped AuNPs (cit-AuNPs) 

In this study, synthesis of citrate capped AuNPs 

(cit-AuNPs) was conducted as reported by Ariffin 

et al. [35]. 250 mL of 1.5 mM of HAuCl4·3H2O was 

initially stirred (1,000 rpm) and heated until boil 

at 100 °C, followed by rapid addition of 25 mL of 

38.8 mM of trisodium citrate solution. The 

reaction mixture was continuously stirred and 

heated until the yellowish gold (Au) solution turns 

red. The suspension was then cooled to room 

temperature and stored in an amber glass bottle 

at 4 °C for further use. 

Fabrication of paper-based colorimetric 

aptasensor 

A paper-based colorimetric aptasensor was 

prepared using a clean Whatman filter paper 

(WFP). The filter paper was cut into rectangular 

shape (size: 0.5 cm (width) x 3.0 cm (length)) and 

rinsed with milli-Q water before dried in an oven 

at 50 °C for 40 mins. Then, 10 rectangular filter 

papers were directly soaked in 20 mL of ethanol 

in a petri dish (diameter: 14 cm) for 1 hour. The 

rectangular filter papers were rinsed 2 times with 

Milli-Q water and left to dry at room temperature 

for 1.5 hours. Subsequently, the dried filter papers 

were immersed in a mixture (consists of 990 μL of 

cit-AuNPs and 10 µL of DNA aptamer (3 nM)) for 

1 hour, and then rinsed with Milli-Q water. 

Afterward, the modified filter paper (WFP-

AuNPs-Apt) was rinsed with Milli-Q water and left 

to dry at room temperature for 10 mins before 

used for detection. The fabrication steps of WFP-

AuNPs-Apt conducted in this study is displayed in 

Figure 1. 

Characterisation of cit-AuNPs  

Ultraviolet-Visible (UV-Vis) Spectroscopy  

An UV-Vis spectrophotometer (UV-3600i plus, 

Shimadzu, Japan) was used for characterization of 

cit-AuNPs. The synthesized cit-AuNPs was diluted 

with Mili-Q water and then placed in a quartz 

cuvette. The absorbance was measured from 400 

nm to 800 nm. The stability of the cit-AuNPs was 

also examined by measuring the UV-Vis 

absorbance of cit-AuNPs for a period of 49 days. 

High resolution transmission electron microscopy 

(HRTEM) 

The shape and particle size of synthesized cit-

AuNPs were characterised using HRTEM (JEOL, 

JEM-2100F, Japan). The synthesized cit-AuNPs 

(10 µL) was deposited on top of the copper (Cu) 

grid and air dried for 4 hours at room temperature 

before the analysis was performed at an 

acceleration voltage of 160 kV. The particle size 

distribution of the cit-AuNPs was evaluated 

through a random sampling of 200 individual 

particles from the TEM images to ensure 

statistical accuracy.   

 

Figure 1. Fabrication steps of the WFP-AuNPs-Apt proposed in this study 
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Preparation of MLT stock and working solutions 

To prepare 100 mL of 2.5 mM of MLT stock 

solution, a desired amount of MLT was added into 

a mixture of acetonitrile and MiliQ water (volume 

ratio: 1:1). Different concentrations (100, 200, 

300, 400, 500, 600, 700, 800, 900, and 1,000 µM) 

of MLT solutions were then prepared from MLT 

stock solution to develop a calibration curve for 

MLT detection. 

Calibration curve for MLT detection  

To construct a calibration curve, the fabricated 

WFP-AuNPs-Apt aptasensor was evaluated for 

MLT detection using different concentrations of 

MLT (100 to 1,000 µM). Each detection 

experiment was conducted in triplicates at room 

temperature, and a similar experimental 

procedure was applied for the blank. A 

smartphone (iPhone 7) was used to acquire digital 

images of the solutions with the aid of a 3D-

printed image capturing box. The schematic 

diagram for the quantitative determination of 

MLT using the WFP-AuNPs-Apt sensor assisted 

with image analysis is illustrated in Figure 2. At 

first, 7 μL of MLT was dropped onto a point on the 

WFP-AuNPs-Apt sensor located 0.5 cm from the 

bottom margin and 0.25 cm from the left margin. 

After dropping with MLT, the WFP-AuNPs-Apt 

sensor was then placed in the 3D-printed image-

capturing box. The dimensions of the 3D-printed 

image capturing box are shown in Figure 3. The 

aptasensor was captured using a smartphone 

under constant conditions after a detection period 

of 3 minutes, at a fixed distance of 7.5 cm between 

the smartphone and the WFP-AuNPs-Apt sensor. 

Afterward, the images were imported into a 

laptop and analysed using ImageJ software to 

quantify colour intensity in terms of red, green, 

and blue (RGB) values. A fixed rectangular region 

of interest (ROI) was selected in each image using 

the selection tool of the software to ensure 

consistency across samples. The RGB values 

within the selected area were then measured 

using the software, and the resulting data were 

displayed on the screen. These RGB values were 

subsequently exported and further processed in 

Microsoft Excel, where response (RGB) values 

were calculated based on the equation reported 

by Murdock et al. [36]. Eventually, a calibration 

curve for MLT detection was constructed to 

establish the relationship between ΔRGB and MLT 

concentration. 

 

Figure 2. Schematic illustration of MLT detection using WFP-AuNPs-Apt aptasensor incorporated with image 

analysis 
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Figure 3. Dimensions of 3D-printed image capturing box used in this study 

Image analysis 

The captured WFP-AuNPs-Apt aptasensor 

images were imported into a laptop and analysed 

using ImageJ software to quantify colour intensity 

in terms of red, green, and blue (RGB) values. A 

fixed rectangular ROI was selected in each image 

using the software's selection tool (Figure 4a) to 

ensure consistency across samples. The 

undesired areas adjacent to this region were 

omitted using the Edit → Clear Outside function 

(Figure 4b). Thereafter, the RGB values were 

within the selected area were extracted via 

Plugins → Analyze → RGB Measure (Figure 4c), and 

the resulting values were displayed on the screen 

as illustrated in Figure 4d. These RGB values were 

subsequently exported and further processed in 

Microsoft Excel, where response (RGB) values 

were calculated based on the equation reported 

by Murdock et al. [36]. 

Results and Discussion 

Characterisation of cit-AuNPs 

UV-Vis spectroscopy 

The successful synthesis of cit-AuNPs was 

confirmed by their distinct bright red color by UV-

Vis spectroscopy analysis. This technique is highly 

effective for characterizing various metal 

nanoparticles formation because examination of 

the localized surface plasmon resonance (SPR) 

band offers indirect the evidence which 

supporting the AuNPs formation as reported by a 

previous work [37]. Based on the UV-Vis 

spectrum of cit-AuNPs, as illustrated in Figure 5, a 

localized SPR peak observed at λmax of 521 nm, 

indicating the presence of spherical AuNPs, which 

consistent with the characterization of 20 nm 

AuNPs reported by a previous study [38]. In 

addition, Sangwan and Seth [39] reported that the 

desirable optical properties of successful 

synthesis of AuNPs are within range of 520-525 

nm. 

High resolution transmission electron microscopy 

(HRTEM) 

Based on the TEM image of cit-AuNPs in Figure 

6a, the cit-AuNPs exhibited a predominantly 

spherical shape and well dispersed in the solution. 

The histogram (Figure 6b) shows a relatively 

narrow distribution, with an average particle size 

of 13 ± 0.58 nm. The narrow and well-defined 

peak of particle size distribution show a relatively 

uniform size distribution of NPs that well-

dispersed (monodisperse), with minimal 

aggregation and relatively small in size [40].  
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Figure 4. The captured images are analysed using ImageJ software by following these steps: (a) the ‘rectangular’ 

tool is selected to highlight the desired area with a rectangular shape, (b) the undesirable area of the captured 

image is cleared by clicking Edit → Clear Outside, (c) the RGB values of the cropped image are measured by clicking 

Plugins → Analyze → RGB Measure, and (d) the RGB values are displayed on the screen. 

 

 

Figure 5. UV-Vis spectrum of cit-AuNPs. Inset: image of synthesised cit-AuNPs 
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Figure 6. Particle characterisation of cit-AuNPs solution (a) TEM image of cit-AuNPs, with a scale bar of 50 nm, 

and (b) histogram of cit-AuNPs particle size distribution 

Stability of cit-AuNPs 

The stability of the cit-AuNP colloidal suspension 

was evaluated by monitoring changes in UV–Vis 

absorbance over 49 days using the UV–Vis 

spectrophotometer. The UV–Vis spectra 

corresponding to these periods are shown in 

Figure 7. During this period, the λmax remained 

constant at around 521 nm, which is the 

characteristic SPR peak of cit-AuNPs. According to 

Park et al. [41], the negatively charged citrate ions 

adsorb onto the AuNPs surface, imparting a 

negative charge layer that generates electrostatic 

repulsion between particles. This repulsion 

counteracts the attractive van der Waals forces, 

preventing aggregation and helping maintain a 

uniform distribution of charge, which stabilise the 

cit-AuNPs. Further analysis of these results was 

performed using a paired t-test, and the findings 

are presented in Table 1.  

Table 1 shows the results of a paired t-test 

analysis of the mean absorbance of cit-AuNPs 

measured at λmax over 49 days. The t-test results 

(Table 1) were used to statistically compare the 

absorbance values measured at λmax on day 1 with 

those collected on subsequent days (day 3 

through day 30). The standard deviations (SDs) of 

the mean absorbance values are low (0.0008 to 

0.0684) over time, suggesting minimal 

experimental variation that was not sufficient to 

affect the overall statistical significance. The 

obtained p-values were 0.2793 and 0.3149 for 

days 3 and 7, respectively, both of which were 

greater than 0.05. This indicates that there was no 

statistically significant difference in absorbance 

between days 1 and 3, as well as between days 1 

and 7. However, most of the p-values less than 

0.05 were observed from day 10 until day 49, 

indicating that the absorbance measured at λmax 

changed significantly beginning on day 10. This 

minor reduction in absorbance intensity may 

indicate a small degree of sedimentation or optical 

dilution over time. However, the unchanged λmax 

confirms that the nanoparticles did not undergo 

significant aggregation or shape transformation. 

No evidence of aggregation, peak broadening, or 

red-shifting of the SPR peak was observed, 

suggesting that the cit-AuNPs remained physically 

and chemically stable under the given storage 

conditions for 7 days. 

Mechanism of MLT detection using cit-AuNPs-Apt 

The schematic diagram of MLT detection 

mechanism using the cit-AuNPs-Apt proposed in 

this study is shown in Figure 8a. Upon Apt 

addition to cit-AuNPs, the Apt replaced the citrate 

ligands on the surface of monodispersed AuNPs 

via physical adsorption due to stronger Au-S bond 

that displaces the weakly citrate bond, and makes 

the AuNPs more stable [42]. 
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Figure 7. Variation in UV-Vis absorbance of cit-AuNPs from day 1 to day 49 

 

Figure 8. (a) Schematic illustration of MLT detection mechanism using a WFP-AuNPs-Apt sensor; (b) TEM images: 

(i) cit-AuNPs-Apt remain dispersed in the absence of MLT, and (ii) cit-AuNPs-Apt aggregate in the presence of MLT 

(scale bar: 100 nm) 

Table 1. Independent t-test results of mean absorbance of cit-AuNPs at max 

Day 1 3 7 10 14 21 28 35 42 49 

Mean 

absorbance 

2.5073 2.4869 2.4812 2.4027 2.2702 2.2663 2.1606 2.0700 2.0609 2.0105 

SD 0.0190 0.0055 0.0008 0.0154 0.0321 0.0310 0.0214 0.0684 0.0639 0.0385 

P- value - 0.2793 0.3149 0.0155 0.0248 0.0223 0.0031 0.0507 0.0451 0.0176 
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Figure 9. Calibration curve for MLT detection using WFP-AuNPs-Apt sensor, showing the correlation between 

MLT concentration and the corresponding colorimetric change (ΔRGB). The images above the graph represent the 

visual color changes associated with varying MLT concentrations, illustrating the sensor's response. 

In the presence of an analyte (MLT), the aptamer 

changes its conformation from a random coil to a 

rigid structure due to its strong affinity for the 

analyte, and dissociates from the AuNPs to bind 

with the analyte, resulting in the AuNPs 

aggregation [43,44]. This aggregation caused 

color change of cit-AuNPs from red to deep 

reddish-purple. The aggregation of cit-AuNPs-Apt 

after MLT detection was further confirmed by 

TEM images (Figure 8b). The TEM image shows 

that the cit-AuNPs-Apt remain dispersed in the 

absence of MLT (Figure 8b (i)), while aggregated 

upon MLT addition (Figure 8b (ii)), forming cit-

AuNPs-Apt-MLT complexes. 

Calibration curve 

The fabricated WFP-cit-AuNPs-Apt sensor was 

applied for the quantitative analysis of MLT in the 

range of 100 to 1,000 µM. A visible color change in 

the WFP-cit-AuNPs-Apt sensor was observed 

upon the MLT addition. A calibration curve for the 

MLT detection was generated by plotting ΔRGB 

values against MLT concentrations (Figure 9). A 

good linear relationship (y = 0.0501x + 0.0455, 

where y is the mean ΔRGB value and x is the MLT 

concentration) was obtained over the range of 

100 to 1,000 µM of MLT, with a correlation 

coefficient of R² = 0.9918, indicating a strong 

correlation between ΔRGB and MLT 

concentration. The limit of detection (LOD) was 

calculated to be 0.67 µM based on the equation 

described by Feng et al. [45].  

Conclusion 

A colorimetric aptasensor using cit-AuNPs-Apt 

as a sensing reagent was successfully employed 

for the detection of MLT. The aptasensor enabled 

quantitative detection of MLT using a smartphone 

within 3 minutes. Integration of the aptasensor 

with image analysis proved to be a valuable 

approach for MLT quantification. Under optimal 

conditions, the developed paper-based 

aptasensor demonstrated a linear detection range 

of 100 to 1,000 µM, with a LOD of 0.67 µM. In 

conclusion, a promising paper-based aptasensor 

for the simple and rapid quantitative detection of 

MLT was successfully developed. However, 

further research is needed to assess selectivity 
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and perform real sample analysis to validate the 

practical applicability and reliability of this 

aptasensor for on-site detection. 
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